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Please read the complete manual before attempting to operate your IVC-3D.

WARNING

IVC-3D is a laser product complying as such to the standards EN/IEC 60825-1:2014
and EN/IEC 60825-1:2007. It complies with 21 CFR 1040.10, except for deviations
pursuant to Laser Notice No. 50, dated 24 June 2007. It cannot be considered as a
standalone unit and must only be used as a part of a laser system, which incorporates
additional features and precautions depending on the applicable laser class. See
chapter “1.1 Laser Safety class 2 (2M) laser” and chapter “1.2 Laser Safety class 3B
laser”.

CAUTION

Class 2 (2M) lasers emit visible radiation in the
wavelength range from 400 nm to 700 nm where eye

LAS E R protection is normally afforded by aversion responses
including the blink reflex. However, viewing of the
2 output is hazardous if the user employs optical
instruments within the beam or suppresses the blink

reflex intentionally.
Ptotal < 20mW, DC or pulsed -; A =600-700nm o
b D e Do not stare into beam.

P < C6 * 1mW within 7mm aperture
EN/IEC60825-1:2014 - Complies with 21 CFR 1040.10 except 3 - q q
for deviations pursuant to Laser Notice No. 50, dated June 24, 2007 ® Do not view the laser beam dlrectly with 0pt|ca|

instruments like magnifying glasses.

LASER RADIATION - DO NOT STARE INTO
BEAM OR VIEW WITH MAGNIFIERS
CLASS 2 LASER PRODUCT

According to EN/IEC 60825-1 : 2014
(Laser class 2M according to EN/IEC 60825-1 : 2007)

LASER i DANGER
g g g Class 3B lasers are considered dangerous to
3B KA E E ; your retina if exposed. This includes looking directly
P < 100mW § E g 2 into a reflection from a specular (mirror-like) surface.
- =600-700nm bsuz Viewing diffuse reflections are normally safe. Certifica-
AVOID EXPOSURE TO BEAM g H gs tion is given only on systems that fulfil all safety
EXPOS":IT(':OH’:. SEMFAS'.?%/:‘E Rﬁggg“zi%“ § ;g g 2 requirements for 3B laser systems.
e Class 3B laser products must bear warning
WARNING - LASER RADIATION and certification labels.
AVOID DIRECT EXPOSURE TO BEAM e During installation and alignment appropriate eye
CLASS 3B LASER PRODUCT protection must be used.

According to EN/IEC 60825-1 : 2014
(Identical laser class for version EN/IEC 60825-1 : 2007)

The IVC-3D is a laser product and operation using procedures other than those specified
herein may result in hazardous radiation exposure.

Please read and follow ALL Warning statements throughout this manual.

German versions of the Operating Instructions and Reference manual are available on the CD.

Eine deutsche Version der Bedienungsanleitung und des Referenzhandbuchs finden Sie auf der
beigelegten CD.
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WARNING

Do not open the IVC-3D

The IVC-3D unit should not be opened; the IVC-3D contains no user serviceable parts
inside. Opening the IVC-3D unit may result in hazardous radiation exposure.

Tum off the power to the IVC-3D before maintenance

The power to the IVC-3D must be turned off before any maintenance is performed. Failure
to turn this power off when maintaining the unit may result in hazardous radiation expo-
sure.

ISM Radio Frequency Classification - EN55011 —
Groupl, Class A

Warning: Class A equipment is intended for use in an industrial environment. There may
be potential difficulties in ensuring electromagnetic compatibility in other envi-
ronments, due to conducted as well as radiated disturbances.

Explanations:

Groupl - ISM equipment (ISM = Industrial, Scientific and Medical)

Group 1 contains all ISM equipment in which there is intentionally generated and/or used
conductively coupled radio-frequency energy which is necessary for the internal functioning
of the equipment itself.

Class A equipment is equipment suitable for use in all establishments other than domestic
and those directly connected to a low voltage power supply network which supplies build-
ings used for domestic purposes.

Class A equipment shall meet class A limits.

Note: Although class A limits have been derived for industrial and commercial establish-
ments, administrations may allow, with whatever additional measures are necessary, the
installation and use of class A ISM equipment in a domestic establishment or in an estab-
lishment connected directly to domestic electricity power supplies.

Disclaimer

SICK uses standard IP technology for its products, e.g. |0 Link, industrial PCs. The focus
here is on providing availability of products and services.

SICK always assumes that the integrity and confidentiality of data and rights involved in
the use of the above-mentioned products are ensured by customers themselves. In all
cases, the appropriate security measures, e.g. network separation, firewalls, antivirus
protection, patch management, etc., are always implemented by customers
themselves, according to the situation.

Product/Application not in scope of RoHS-Directive

This product is specifically designed for applications in large-scale fixed installation
according to article 2 (4) e), RoHS 2011/65/EU and is accordingly allowed to be
applied solely in such applications. For applications out of the described scope, the
product is neither adequate nor admitted. Therefore, for such an application SICK
cannot take any guarantee or liability.

©SICK AG * Advanced Industrial Sensors * www.sick.com e All rights reserved 3
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Introduction Chapter 1

Introduction

The IVC-3D is a Smart Camera that combines imaging and analysis into one camera hous-
ing. The camera performs inspection, location or measurement of objects in order to
enhance production yield, control production or perform quality control.

The major advantage with the IVC-3D is that it can see three dimensions. Highlighting
surface defects depending on topography is now already done in the image capturing. With
tools that are defined to measure heights, volume, shapes etc., previously tricky meas-
urement tasks are now easily solved with the calibrated 3D Smart Camera.

The IVC-3D is a configurable camera that can be programmed to perform many different
applications. The program is set up through a graphical user interface called IVC Studio.

The product package contains:
e |VC-3D with about 140 image processing tools grouped in 13 different categories

e |VC Studio, which is the PC software to configure the camera and make application
programs

e |VC Emulator, which is a software program behaving like an IVC camera. The Emulator
makes it possible to develop application programs without being connected to an IVC
camera.

This document contains installation information, which explains how to get the first live
image from the camera, a getting started chapter guiding the user through the first step
program, a functional overview, and hardware specifications. For information about how to
use the Emulator, please refer to the IVC-3D Reference Manual.

11 Laser Safety class 2 (2M) laser

An IVC-3D product with a type code as IVC-3Dxxx1x is equipped with a class 2 laser
according to EN/IEC 60825-1:2014 (2M according to EN/IEC 60825-1:2007). It
complies with 21 CFR 1040.10 except for deviations pursuant to Laser Notice No. 50,
dated June 24, 2007. Class 2 lasers emit visible radiation in the wavelength range
from 400 nm to 700 nm where eye protection is normally afforded by aversion
responses including the blink reflex. However, viewing of the output is hazardous if the
user employs optical in-struments within the beam or suppresses the blink reflex
intentionally.

e Do not stare into beam.
¢ Do not view the laser beam directly with optical instruments like magnifying glasses.

LASER
2

Ptotal < 20mW, DC or pulsed -; A =600-700nm

P < C6 * TmW within 7mm aperture

EN/IEC60825-1:2014 - Complies with 21 CFR 1040.10 except

for deviations pursuant to Laser Notice No. 50, dated June 24, 2007

LASER RADIATION - DO NOT STARE INTO
BEAM OR VIEW WITH MAGNIFIERS
CLASS 2 LASER PRODUCT
according to EN/IEC 60825-1:2014
(2M according to EN/IEC 60825-1:2007)

©SICK AG * Advanced Industrial Sensors * www.sick.com e All rights reserved 5
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12 Laser Safety class 3B laser

An IVC-3D product with a type code as IVC-3Dxxx2x is equipped with a Class 3B laser.
In addition to the considerations for class 2 (2M) products, class 3B systems are
subject to a number of safety requirements in order to be certified. According to EN/
IEC 60825-1:2014 and EN/IEC 60825-1:2007 the following must be presentin a
system containing a class 3B laser product:

o A laser safety officer must be named.

¢ A key-box with a removable key must be present in the system. Without the key it
should not be possible to power-on the laser unit of the IVC-3D.

¢ A remote interlock connector - a connector readily available for connecting a remote
emergency stop or remote barrier interlock must be present in the system.

e Alaser indication lamp must be present in the system.

| /AWARNING /A AVERTISSEMENT /i\ WARNUNG

LASER
3B

P < 100mW
A =600 - 700nm

AVOID EXPOSURE TO BEAM
EXPOSITION AU FAISCEAU DANGEREUSE
NICHT DEM STRAHL AUSSETZEN

Complies with 21 CFR 1040.10 exceptf§l
for deviations pursuant to Laser Notice|
No. 50, dated June 24, 2007

EN/IEC60825-1:2014 -

WARNING - LASER RADIATION
AVOID DIRECT EXPOSURE TO BEAM
CLASS 3B LASER PRODUCT
according to EN/IEC 60825-1:2014
(identical laser class according to EN/IEC
60825-1:2007)

In addition to these requirements there may be local regulations on class 3B laser
systems. It is important that you establish that the class 3B systems meet the regulations
that apply in your country.

The IVC-3Dxxx2x product does not fulfill the requirements above as a standalone unit.
Therefore a terminal key box with removable key, including connection to a remote inter-
lock and an external lamp for laser indication must be present in the system. For this
purpose an ICT-R box can be used. The ICT-R box also includes a laser on-delay required
by 21 CFR 1040.10.

The figure below shows how the ICT-R box is connected to the IVC-3D camera.

©SICK AG * Advanced Industrial Sensors * www.sick.com ¢ All rights reserved 8011007/ZMC8
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PC with IVC Studio

—
==
External warning _l!l
P Y I
@:.n [0 C ey

D
90...260 VAC 24V DC

B Photo switch
Q Encoder

D—
I —

-

N IVC-3D

Figure: How to connect the ICT-R box with an IVC-3D containing a Class Ilib / 3B laser.

The ICT-R box is available from SICK as an accessory with part number 1029242.

13 Laser lifetime optimization

To optimize the lifetime of the laser in the IVC-3D camera, please consider the following:
e If possible, use flashed laser to minimize the burn-time for the laser.
e Turn off the laser when it is not in use.

e Keep the ambient temperature as low as possible (0°C to 40°C). A rule of thumb
indicates that a 10°C lowering of the ambient temperature doubles the laser life-
time. l.e. an ambient temperature of 20°C will by this rule allow the laser twice the
burn-time compared to an ambient temperature of 30°C.

Note: A Class 3B laser is more sensitive than a Class 2 (2M) laser due to another type of
the laser diode and higher laser diode current.

8011007/ZMC8 ©SICK AG * Advanced Industrial Sensors * www.sick.com e All rights reserved 7
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14 Cleaning recommendations

Build-up of dirt on IVC-3D’s windows may affect the performance of the measurements. It
is therefore recommended to perform maintenance regularly.

Warning

The power to the IVC-3D must be turned off before any maintenance is performed. Failure
to turn the power off when maintaining the unit may result in hazardous radiation expo-
sure.

141 IVC-3D with safety glass windows

An IVC-3D with type code as IVC-3Dxxx1 is equipped with anti-reflex coated safety glass
windows. It is recommended to use compressed air to blow dust away. Clean with a dry or
a damp cloth using a mild detergent if necessary. Do not use any abrasive or solvent
cleaners.

142 IVC-3D with plastic windows

An IVC-3D with type code as IVC-3Dxxx2 or IVC-3Dxxx3 is equipped with PMMA plastic
windows. The plastic windows are sensitive to scratches and use of aggressive detergents.
It is recommended to use compressed air to blow dust away. Clean with a dry or a damp
cloth using a mild detergent if necessary. Do not use any abrasive or solvent cleaners.

143 IVC-3D with plastic windows and stainless steel housing

An IVC-3D with type code as IVC-3Dxxx3 is equipped with PMMA plastic windows and a
stainless steel housing. This camera is IP 67-rated and ECOLAB tested using the following
cleaning agents:

e P3-topax 56

e P3-topax 66

e P3-topax 990

e P3-topactive 200
e P3-topactive DES

IVC-3Dxxx3 is not verified to withstand high pressure wash down. It is recommended to
wash the IVC-3D separately and to cover it with for example a plastic hood during the high
pressure washing. With this solution no water or moisture will risk to penetrate into the
stainless steel housing, and aggressive detergents will not risk damaging the plastic
windows.

For maintenance of the plastic windows please see above.

©SICK AG * Advanced Industrial Sensors * www.sick.com ¢ All rights reserved 8011007/ZMC8
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Installation Guide

21 Preparing the IVC System

The IVC System consists of one or more devices and the development environment [VC
Studio. Make sure that all ordered parts are delivered.

The following parts must be present in a functioning system:

e A device, in this case a camera

e |VC Studio development environment

e A power I/0 cable

e An Ethernet cable

211 Preparing the Power I/0 Cable

The orange power I/0 cable is open in one end. It contains eight wires. The blue is ground
and the brown is +24 volts DC. Apply an appropriate connector but do not connect it at this
point.

212 Preparing the Device

The figure below shows the position of the connectors on the back of the device.

@ ® ®
© 0 @ © o
@ ® ®

Follow the steps below to prepare the device for operation.

1. Remove the protection caps covering the connection for the cable sockets that you
want to use.

2. Connect the Ethernet cable to the socket marked Ethernet on the device.
Connect the power |/0 cable to the socket marked Power on the device.

4. |If you are using an encoder with the camera connect the encoder cable to the socket
marked Encoder on the device.

w

8011007/ZMC8 ©SICK AG * Advanced Industrial Sensors * www.sick.com e All rights reserved 9
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22 System requirements

In order to run the IVC Studio software, the following prerequisites must be fulfilled.

221 PC requirements

The following specifications are required for the PC:

e Fast Ethernet connection (100 Mbits/s)

¢ Minimum of 550 MHz CPU, 128 MB RAM

e CD-ROM or DVD-ROM

o Windows XP Service Pack 3, Windows Vista Business Edition (32 bit) or Windows 7
e Graphic support for OpenGL 1.3 or higher

222 Screen requirements

¢  Minimum of 1024x768 pixel resolution

223 Connection requirements
Either of the following communication connections is required for the camera to PC con-
nection:

e Camera directly to a PC equipped with a network interface card (NIC) that automatically
applies an internal crossover

e Camera directly to a PC via Ethernet crossover cable or switch

Note: The PC must be connected to the device either through a switch or directly with a
crossover cable. The IVC devices do not support wireless connections or connec-
tions through a hub.

224 PC Access permission

e Windows administrator account

©SICK AG * Advanced Industrial Sensors * www.sick.com ¢ All rights reserved 8011007/ZMC8
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Installation Guide Chapter 2

23 Installing IVC Studio

To install IVC Studio, insert the CD in the PC and go through the Setup Wizard.

The serial number that is preset in the installer should be used by most customers. If you
have received a custom serial you should enter that instead. The serial and language
choice can be changed in IVC Studio after the installation.

During the installation you may have to restart the PC.
After the installation the studio will be operating in Administrator mode. There is also an
operator mode, which limits the available studio functionality. You can change to operator

mode by selecting Options > Disconnect Administrator and entering a user name and
password from the list below.

User name Password
Administrator admin
Operator operator

24 Receiving an Image from the Device

The device must have an IP address in order to communicate with the PC over Ethernet.
The way to provide the IP address depends on how the device is connected to the PC. The
three typical options are:

¢ The device is connected through a switch to a network with a DHCP server. In this case
the device will automatically get a dynamic IP address. This is the default setting.

e The device is connected through a switch to a network without a DHCP server. In this
case a network technician provides an unoccupied IP address.

¢ The device is connected directly to the PC either through a switch or a cross-over
Ethernet cable. In this case the IP address of the device should use the same sub-net
as the PC. The PC IP address is shown in the device configuration window as local IP
address.

Note: The PC must be connected to the device either through a switch or directly with a
crossover cable. The IVC devices do not support wireless connections or connec-
tions through a hub.

At delivery the IP parameters of the device are configured as follows:

IP 192.168.0.110
Netmask 255.255.255.0
Gateway 0.0.0.0

DNS 0.0.0.0

WINS 0.0.0.0
TimeServer 0.0.0.0

DHCP 1

DHCP Wait Save 5

DHCP IP AutoConfiguration | 1

©SICK AG * Advanced Industrial Sensors ¢ www.sick.com ¢ All rights reserved 11
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Follow the steps below to receive an image from the device.

5. Make sure the PC is connected to a server or a switch and connect the Ethernet cable
from the device to the same network server or switch as the PC. If you connect the
device directly to the PC make sure you use a crossover Ethernet cable.

6. Connect the power I/0 cable to +24 volts and GND.
7. Start IVC Studio.

If you start IVC Studio for the first time, enter a company name and the serial number,
and log in as administrator.

8. Choose File > Open Product... and open the product Empty.prd.
9. Click Devices in the left pane in the main window.

If you are connected to a network with a DHCP server, the device should be displayed
in the right pane.

If the device is running a program (STATUS: RUN), stop the program by right-clicking
the device in the right pane and choose Stop Program.

10. Choose Options = Configuration from the IVC Studio menu bar.

11. Select Ethernet Devices in the dialog box and click Ethernet Devices Configuration.
A list of all connected devices appears.

12. Select the device.
All available settings appear in the right pane.

13. Make the necessary settings, depending on your connection method:

Connection method Parameter Value
Through a switchto | ID Set to the customer serial
a network with a number or another number that
DHCP server is unique in the network.
Through a switchto | IP An unoccupied IP address,
a network without a provided by a network techni-
DHCP server cian.

ID Set to the customer serial

number or another number that
is unique in the network.

Netmask Your network’s netmask, pro-
vided by a network technician.

Gateway If there are subnets in the
network, the IP address of your
network’s gateway. This should
be provided by a network tech-
nician.

DHCP Set to O (zero).

DHCP IPAutoConfiguration Set to O (zero).

Directly to the PC IP All settings are the same as for

either through a ID a network without DHCP server

switch or a cross- Netmask (above). The IP address of the

over Ethernet cable device should use the same
DHCP subnet as the PC.

DHCP IPAutoConfiguration

See appendix B of the IVC-3D Reference Manual for detailed information on the
parameters.

14. Save the settings and close all dialog boxes.

15. Choose Options > Configuration or press Ctrl-F5 until the device appears in the
device list.

12 ©SICK AG * Advanced Industrial Sensors ¢ www.sick.com ¢ All rights reserved 8011007/ZMC8
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16.
17.

18.
19.

20.

21.

Chapter 2

This will search the network for available devices.

Right-click the device in the right pane and choose Select Program. In the dialog box,
select the program Empty and click OK.

Right-click the device in the right pane and choose Select Table. In the dialog box,
select the program EmptyTable and click OK.

Click Programs in the left pane in the main window, and select the program Empty.
The program list, image banks and tools toolbar are displayed in the right pane.
Click on the Grab setup tool (on the Image tab in the toolbar).
The Grab setup tool is added to the program list.
Double-click the Setup button on the program step in the program list.
T Vi
Setup 29%
O\ the o>
The Grab setup dialog box is displayed.

Aim the device at a suitable target, and adjust the field of view until you can see the
profile of the target in the preview.

W IVE Sacdia Plugln - Grab Sstup
Basxc | Advanced [
Fieid of View
b o
0 0
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Functional Overview

31 IVC-3D Camera

The IVC-3D camera contains a powerful microprocessor that is tailored for image analysis
and especially analysis of 3D images. The processor can perform a number of commands
- or tools - that are used for example for capturing an image, finding an edge in an image
or setting one of the camera’s output signals.

 Working Memory ./__‘ -
= B 2l

Active Active Image Data
9 Program  Table Banks Blocks

N

/

~

Program Saved Saved
Banks Images Data Blocks

1
1
1
1
1
1
1
/

The camera also has a working memory, which contains the following:

¢ Active program, which is a sequence of commands that are used for analyzing the
images.

e Active table, which is used for reading and storing values that are used during the
analysis.

¢ A number of image banks, which each contains an image captured and processed by
the camera. An image bank may contain either a 3D image or a profile.

e Data blocks, which are used by some tools for storing or reading additional data. For
example, some pattern recognition tools (Teach tools) create and save data in a data
block, which can later be used by other tools (Match tools).

In addition, the camera has a flash memory, which is used for permanent storage. The
flash memory contains the following:

e Program banks, which are used for storing programs and tables that can be loaded into
the camera’s working memory. A program bank always contains both one program and
one table.

e Saved images, which can be used for example as a basis when teaching the camera
patterns to recognize.

e Saved data blocks, containing for example pattern recognition data to be used by
Match tools, so that the pattern does not have to be taught before running a program.

14 ©SICK AG * Advanced Industrial Sensors * www.sick.com ¢ All rights reserved 8011007/ZMC8
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311 3D Images

A 3D image shows the topology of an object, or the distance from the bottom (or reference
plane) to a point on the surface of the object. The brighter a pixel is in the image, the
higher up that point is on the object.

X (width)

I >

z (height)

y (transport)

Y
X (width) Y (transport)

Since each pixel in the 3D image represents a height the pixel values are displayed in milli-
meters, and not as gray or color values as in ordinary digital images. The resulting height
value is measured from a reference plane located at a fixed distance from the camera.

This means that the units of the 3D coordinates in an image are pixels along the x- and y-

axis, and millimeters along the z-axis. The coordinates in the 3D image can however easily
be converted to millimeters by using a tool in the camera.

3.12 Profiles

A 3D image is generated from profiles, where each profile represents a cross-section of the
object. A profile is created when the object passes under a laser beam, which is reflected as
a line on the object. When viewed from an angle, the line shows the contour of the object.

x Y

l Profile

The coordinate system in profiles is the same as in 3D images - that is pixels along the
x-axis and millimeters along the z-axis.

313 Suppressing ambient light

The laser line used to create 3D images has a certain wavelength range, and the IVC-3D
has built-in filters that suppress ambient light. However, sunlight and also some standard
light sources used at factory floors contain light with the same wavelength range as the
laser. For a robust measurement day and night, all over the year, it is recommended to
shroud the inspection area from ambient light, especially sunlight.

8011007/ZMC8 ©SICK AG * Advanced Industrial Sensors * www.sick.com e All rights reserved 15
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314 Capturing 3D Images

The camera takes a suitable number of profiles as the object passes under the laser. By
knowing the distance that the object moved between two profiles the camera can build a
3D image of the object from the profiles.

The camera assumes that the distance between the profiles is constant. Therefore it is
important to make sure that this is actually the case, in order to generate accurate 3D
images. There are two ways to achieve this:

* Make sure that the object is moving with a known and constant speed. The speed is
specified in the program, and the camera will then take profiles with a constant time
interval.

* Use an encoder. In this case, the encoder will trigger the camera to take a profile when
the object has moved a certain distance.

It is strongly recommended to use an encoder if you intend to measure for example the
shape or volume of the objects. If no encoder is used, the results of the analysis may be
inaccurate if the speed of the objects varies.

Object is moving with Object is moving slower The speed of the
the expected speed than expected object is uneven

3.15 Missing Data

Sometimes the laser line on the object is hidden by other parts of the object. This makes it
impossible for the camera to decide the height of the part of the object that is obscured. In
the resulting 3D image, such areas are represented with missing data, which is displayed
as black or holes when viewing the image.

o — —

z
| A Profile is missing

[ Profile x

Normally, the tools that are used for analyzing the 3D images ignore missing data. However,
some tools treat missing data as a height value of O mm. This may affect the result of the
analysis, for example an edge could be detected at a location in the image where there are
actually missing data. A list of those tools is found in appendix C in the reference manual.

The camera has a tool for removing missing data from an image and thereby minimizing
the impact on the analysis made by such tools. The Fill Missing Data tool assumes that the
height of the hidden area is same as the area surrounding it, and thus “fills in the hole”.
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3.2 IVC Studio

IVC Studio is used for developing the programs that are used by the cameras when
performing inspections - that is, analyzing images. IVC Studio can handle both 2D and 3D
cameras.

When you develop a program in IVC Studio, you work with a product. A product in IVC
Studio is a great help for handling all the devices (usually cameras), programs and tables
that are needed for a certain inspection.

The product contains a list of the used devices, and copies of all programs and tables that
are used by the devices. Normally, each device has one program and one table associated
to it, which is also the program and table that are currently in the working memory.

To be able to work with a program in IVC Studio, it must be associated with a device. The
device can be either a hardware camera or the Emulator, see below. A program is always
executed on a device - and never on the computer. The computer is mainly used for
building and modifying the programs on the devices, and to display the results sent from
the devices.

Devices

Cameral .. Camera2 Emulator

I
1

1

1

1

1

l

1 .

1 << Uses >>
1 Programs . '  Tables
1 . '
1

1

1

1

I

1

1

1

» NS
Label y % LabelTable
FillLevel % FillTable

321 IVC Emulator

The Emulator is a software behaving like an IVC camera, and can be used instead of an
IVC camera. The Emulator is available in the IVC Studio development environment, and it
makes it possible to develop programs when there is no IVC camera available. The Emula-
tor can emulate both 2D and 3D cameras. The main difference between the Emulator and
a camera is that the former uses a predefined set of images stored in an image folder on
the PC, whereas the latter views live images.

322 Programs in Development and Production

During development, you build the program in IVC Studio but the program is automatically
downloaded to the associated device.

When a program (or program step) is executed it is executed in the camera, and the results
are sent back to IVC Studio where they are displayed.

Program steps
Table values

Images
Result values

When the development of a program is finished and it is ready to be used, the program
(and table) is downloaded to the device and started.
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After this it is not necessary to use IVC Studio any more. It may be used to display the
results from the program, for example to signal when faults occur. But the device can also
be used as a stand-alone unit, where other equipment is used for controlling the device
and displaying the output. For example, you could set up a web page on the camera and
then monitor the camera from a web browser on any computer on the network.

Programs
Tables

Input
Output

323 Saving Programs

When you save a product in IVC Studio, the included programs and tables are saved with
the product on the computer. Nothing is saved on the device when you save the product.
This is not a problem since the program associated with the device is automatically loaded
into the device as soon as the program is started or edited in IVC Studio.

3
___________ i|I

i Copied \ Flash
' automatically Memory
. :
Cameral Associated ! . '
Program ! E
Program !
Camera 2 % Bagnks ]
Associated ]
Table ]

. Copy values
. manually

________________________

The programs and tables may be stored manually on the device as well. The flash memory
in the device contains a number of program banks, each of which can contain a program
and a table.

When you store a program in the flash memory, you always store the active program and
table, which are currently in the working memory of the device.

A program stored in program bank O will automatically be started when the device is
powered up.
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33 Handling Multiple Products

A device may be used in several products, using different programs and tables depending
on the product. This makes it easy to use the same camera for performing different in-
spections. Just create one product for each inspection, and in each product associate the
program and table to be used for the specific inspection.

For example, there are three cameras set up by a production line, and we are producing
two different items on this production line - a transparent bottle and an opaque jar. For
the bottle we can use IVC-2D cameras to inspect both the label on the front and the fill
level, but for the jar we need to use an IVC-3D camera to inspect the fill level.

. I Device 3

Device 2

Device 1 \ Device 1
Product: Bottle — — — — — Product:Jar — — — — — —
Dev Program Table | | Dev Program Table \
| 1 Label Bottle_Label_Table 1 Label Jar_Label_Table |

2 Bottle_FillLevel Bottle_FiIILeveI_TabIe| |

3 Jar_FillLevel Jar_FillLevel_Table |
- - — — — — — 7\

—_— — — — — — — — — —

To achieve this we create two products in IVC Studio with the following contents:

Product: Bottle

Device Program Table
1 Label Bottle_Label_Table
2 Bottle_FillLevel  Bottle_FillLevel_Table

Product: Jar

Device Program Table
1 Label Jar_Label_Table
3 Jar_FillLevel Jar_FillLevel_Table

When switching between producing the two products, we can simply open the product in
IVC Studio to load the corresponding programs and tables into the devices. If we would
change the design of the label for the bottle, we can just change the values in the table
Bottle_Label_Table to suit the new design. If necessary we could also make a copy of the
program Label, modify it, and associate the modified program with device 1.
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Getting Started

In this chapter we will introduce the basics in IVC Studio and learn how to:

e Create a product in IVC Studio in which to write the program

¢ Write the program - that is adding program steps and setting parameters
e Test and debug the program

As an example we will build a simple program that slices a loaf of bread in a number of
pieces of equal volume (or weight if we can assume that the density is constant). One way
to achieve this is to:

e Capture a 3D image of the loaf

¢ (Calculate the total volume of the loaf and divide that volume with the desired number
of slices to get the volume of each slice

¢ Move along the 3D image from one end to the other, while calculating the accumulated
volume of the part of the loaf that we have covered

Slices V

Scanning direction
r ”h\_.——————"
1t
Pl

=

- . Accumulated volume

A

When the accumulated volume is equal to (or larger than) the desired volume of a slice,
the current position is stored and the accumulated volume is reset. In a real production
environment, the camera could control a knife that slices the loaf at the correct places.

When writing a program in IVC Studio you can use either a hardware camera or, if no such
is available, the Emulator.

In the following sections it is assumed that a hardware camera is used, and that both the
camera and IVC Studio are installed and are working properly. How to install the camera
and IVC Studio is described in the installation instruction. To capture 3D images you would
also need movement and some kind of trigger for triggering the 3D image grab. It is also
strongly recommended to use an encoder for capturing accurate 3D images.

How to use the Emulator is described in section Using IVC Studio in the IVC-3D Reference
Manual.

41 Creating a Product

Before starting to write the program, we need the following:
e A product to work with

e A device to use in the product (in this case a camera)

e A program written for the device

¢ A table used for the program in the device

A product in IVC Studio is a collection of devices (usually cameras) that are used for per-
forming an inspection, for example of loafs of bread on a production line. Each device
contains one or more programs that instruct the device how to perform the inspection.
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A program is a list of commands, or tools, that the device executes one by one, in order to
capture images, analyze them and draw conclusions from them. To its help, the program
has a table that it can read values from and store results in.

e e e e e, Er e, e, — e — = — - ~
I Product 1
1 1
1 Devices |
| 1
I (= t == I
1 S 1
I Cameral ‘. Camera2 Emulator I
: << uses >> I
| Programs Tables :
1 «° \\ 1
1 % Label T LabelTable 1
1 me= 1
1 1
I % FillLevel FillTable I
1 == 1
1 1
| 1
1 !

411 Create a Product

The first step is to create the product to work with:

1. Start IVC Studio and log in.

If you just installed IVC Studio, the default user and password can be found in the
installation instruction.

2. Choose File > New Product from the IVC Studio menu bar.
A new empty product named New Product is opened.

The main window shows the contents of the currently open product. The left pane shows
the different categories of objects that the product may contain, that is; devices, programs
and tables.

Clicking on one of the categories will display the objects contained in the product. Since
the product was just created, all categories are empty, with the exception of Devices,
which contains all devices that are available.

® 1vC Studio - SICK [GettingStarted] : o ] 3|
File ©ptions  Help

i Devices Device | Firrowyare: Versinnl 10 | F‘rograml Tablel Status
= Programs [ 2.00.00 17 STOP
52 Tables [#] IWE-3D211 1 2.00.00 1 STOR
il Macras Cwc-2n 2.00.00 13 STOP

\Chad{ the Selected Device STOP Ioi11 | SICK |2ucyrusru1 16:35 /LI

¥ Left pane Right pane

There is also a fourth category that we haven’t mentioned yet - macros. Macros are basi-
cally small programs that you can call from within regular programs. They can be useful for
reusing blocks of program steps when writing advanced programs.
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412 Select a Device

The next step is to select the device used for the inspection:

3. Click Devices in the left pane of the main window.

The camera is displayed in the right pane. If there are more devices that can be used
by IVC Studio in your network, those will also be displayed there.

4. Select a device by clicking in the checkbox in front of it in the right pane.

You should always select the devices that you intend to use in your product. IVC Studio
periodically updates the information in the device list by polling the devices that are se-
lected in the list.

If no device is selected in the list, IVC Studio will poll every device it can find for informa-
tion. This slows IVC Studio down and may also affect the performance of devices used in
other applications.

413 Create a Program

We are now ready to create the program we intend to build and to associate it with a
device.

The reason for associating the program with a device before building it is that the program
is always run on a device and not on the computer. What you see in IVC Studio when
running a program are just the results, which are sent from the device. If you did not
associate the program with a device, you would not be able to see any result of the pro-
gram or even test the program.

5. Right-click Programs in the left pane of the main window and choose New Program
from the pop-up menu.

Fill in a name for the program in the dialog box and click OK.
7. Click Devices in the left pane of the main window.

8. Inthe right pane, right-click the device that is selected for the product and choose
Select Program from the pop-up menu.

9. Select the program in the list in the dialog box and click OK.

414 Create a Table

There must also be a table associated with the device, so before starting to build the
program we must create a table and associate it with the device:

10. Create the table by right-clicking Tables in the left pane, choosing New Table from the
pop-up menu and filling in a name in the dialog box.

11. Right-click the device that is selected for the product and choose Select Table from the
pop-up menu.

12. In the dialog box, select the table and click OK.
13. Finally, save your changes to the product on the PC by choosing File > Save Product.
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4.2 About Writing Programs

Before starting to write the program, we will take a look at what a program consists of and
the programming environment.

421 Tools

A program is a list of commands - or tools - that are performed by the camera. When the
program runs, the commands are carried out one by one in the order that they appear in
the program list. So when you build a program in IVC Studio, you work with this list of
commands.

Most of the tools have a number of input parameters that can be set. For example when
capturing an image from a camera, you can specify in which image bank to store the

image.

0. Retrieve an image

1 340 .,
1. Find edge (left) 2 520 |}
Image Bank 0
—————————

X coordinate of line Table row 1 |4

Y coordinate of edge 220

2. Find edge (right)
Image Bank 0
Table row 2 |«

X coordinate of line

Y coordinate of edge 340

3. Calculate angle
Point 1
Point 2
Angle 45°

4. Measurement OK? .
Value to compare Result step 3 |-~

Minimum value -5°
Maximum value +5°
Result
OK Not OK

5. Measurement OK

Output number

Signal value Low

6. Measurement not OK
Output number 0

Signal value High l

Many tools also produce results that are available as output parameters. These parame-
ters can be stored in the table or be used directly by other steps in your program.
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422 Programming Window

When you write a program, the main window contains a few additional parts:

e Toolbar - contains the tools that can be used with the device.

e Program List - shows the tools used in the program and the parameters for each tool.
¢ Table - shows the contents of the device’s table.

¢ Image Banks - shows thumbnails of the images currently in the image banks of the

device (if any). The images can be either 3D images or profiles.
¢ Preview - shows the result of the program step when applied to an image.

Tree View Toolbar Image Banks

=0l x|
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Program List -) Preview

The toolbar actually contains several toolbars on which the tools are grouped into catego-
ries. You switch between the categories by clicking the tabs at the bottom of the toolbar.

The program list shows each step in the program as a table. Each step contains:

e The input parameters that can be set for the tool
e The execution time for the tool when executed
¢ The result (return values) from the tool

The program list has four columns that are used for specifying parameter values: Value,
Table, Step and Result. Which column to use depends on what type of parameter value you
want to use; a constant value, a value from the table, or a result from a previous step.

Image banks are used for storing images, just like the table is used for storing values. This
can be very useful, for example if you want to modify the image, but need to use the
original image later on in the program. Note that the images are stored in the camera, and
that the images in the image banks remain there until they are removed or overwritten by
other images.

When working with the IVC-3D camera there are two types of image banks: one that con-
tains 3D images and one that contains profiles. Which image banks that are of each type
depends on how the camera is configured.

The preview window is used by some tools for visualizing the result of the tool. This preview
is useful when you develop your program, but is not generated when the program is run-
ning. The preview window may also be used for setting parameters for certain tools. This is
further described later in this chapter.
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4.3 Adding Program Steps

Now we are ready to start writing our program for measuring and slicing the loaf of bread.

Start by adding the first program step to the program, which should grab a 3D image from
the camera:

14. Click on the name of your program in the left pane in the main window.

A toolbar is displayed at the top of the window, which contains a number of tools that
can be used with the device. Below the toolbar there is a row of tabs, which are used
for switching between different tool categories.

{8 1vC Studio - SICK [GettingStarted] E
File Edt Debug Options Help

TPREIEyd, VY B

mage | Fegion of Interest | Fiter | Edge | Measure | Matching | Circutar | Calculation Fmglam System | Communication

15. Click the Grab tool in the Image category on the toolbar to add the first step to the
program.
The Grab tool is added to the program’s folder in the left pane and to the Program List
in the right pane.

16. Double-click the blue field at the top of the program step and type a description for
the step, for example “Retrieve an image”.

Previous Fesult

Description Walue Table _H —"
Retreive an image
. Grab E
01 = Destination bank of e | ------------
Time of execution [ps] 1} E
01 = Lost images 0

The command is now added to our program. Before we can test the program and view the
image, we should set up the camera to grab the image that we want.

17. Click the Grab Setup tool on the Image toolbar.

18. In the dialog box that is displayed, choose ...before current step and click OK.
The Grab Setup step is added to the program list.

19. Add a description to the step, such as “Set up the camera”.

20. Double-click the Setup field that is located in the bottom left corner of the program
step in the program list.

/\/\/‘ﬁ
Setup 29%

7\ the 1>

The Grab Setup window is now opened.
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21. Inthe Grab Setup window, make the following settings:

Basic tab

Field of view Adjust the sliders Height, Stand-off and Profile width so that you
can view the profile in the preview. You may also have to adjust
the Measurement settings to improve the quality of the profile.

Profile triggering Select Free-running or Encoder controlled, depending on whether
or not you have an encoder connected to the camera.

Analysis Select 3D Image analysis and fill in the number of profiles per
image.

Advanced tab

Profile triggering If you have an encoder, set the number of pulses per millimeter
and profile distance.

Image triggering Select Free-running or Triggered by input signal depending on
whether or not you have a trigger connected to the camera.

ol
=1
-

We are now ready to run the program on the camera and view the image that was retrieved.

22.
23.
24.

25.

26.

Click the Grab Setup step in the program list to select the step.
Press F1 to open up the Reference manual for the Grab Setup step.

Close the manual again and remember to use the F1 button whenever you want to
learn more about a tool.

Choose Debug > Execute Step from the IVC Studio menu, or press the F5 key on the
keyboard.

Select the Grab step in the program list and choose Debug > Execute Step once more.

An image is now retrieved from the camera and stored in image bank O. Double-click
on the image bank to see the 3D image in a larger window, together with a
visualization of the image.

[l 3D visualisation E
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The next step is to calculate the total volume of the loaf of bread. In order to do that we
need to have the following:

¢ A Region of Interest (ROI) that defines where in the 3D image the loaf is located

¢ A surface that defines the conveyor belt on which the loaf is placed. This surface is used
as the zero-level when calculating the volume from the height data in the 3D image.

ROIs for the
conveyor belt

ROI for
the loaf

The ROI for the loaf is created by adding a ROl Rectangle tool to the program. We will set
the parameters specifying the ROI later.

27. Click the ROI Rectangle tool on the ROI toolbar.

28. In the dialog box that is displayed, choose ...before current step and click OK.
The ROI Rectangle step is added to the program list.

29. Add a description to the step, such as “ROI for the loaf”.

The conveyor belt can be found by fitting a surface to areas outside the ROI for the loaf.
This can be done with the following steps:

 Two ROI Rectangle tools that specify areas to the left and to the right of the loaf. If the
conveyor belt is not exactly planar we can compensate for this by using two areas.

¢ A ROI Union tool that makes one (discontinuous) ROI out of the two rectangular ROIs.

e A Fit Surface tool that creates a surface from the height data inside the two rectangular
ROls.

30. Add the following program steps at the end of the program and give them suitable
descriptions:

[ 3 - Conwveyor belt to the left (ROI Rectangle)
% 4 - ROI for the conveyor belt (ROI Union)
=3 5 - Convepar belt level (Fit Surface)
@ £ - Total volume (Volume)

We will add the second ROI, specifying the surface to the right, after we have set the
necessary parameters.
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44 Setting Parameter Values

The input parameters of the tools can be set in a number of different ways:
¢ By manually entering a constant value

e By using interactive setup to set constant values

e By retrieving a value from the table

¢ By using the result from a previous step

e By writing an expression that may combine the methods above

In this section we will look at different ways of setting constant parameter values. Using
tables, results from previous steps and expressions will be shown in the following sections.
One important thing when specifying pixel coordinates in images - coordinates are always
measured from the top, left corner of the image.

X coordinate
f > (width)

Y coordinate

(length)

441 Setting Constant Parameter Values

All the tools that we just added to the program need a number of parameters to be set:

ROI Rectangle * The rectangle that is the region of interest (ROI) in which we expect to
find the loaf or the conveyor belt.

ROI Union *Two ROIs to join. A ROl is specified by referring to the program step in
which the ROl is created.

Fit Surface * An image bank containing a 3D image, a ROl and the type of surface
to fit to the part of the 3D image that is inside the ROI.

Volume * An image bank containing a 3D image, a ROl and a surface to use as

zero-level when calculating the volume inside the ROI. Anything in the
image below the zero-level is ignored when calculating the volume.

To set a constant value manually is really straightforward - just enter the value in the
Value column for the parameter:

31. Select the Fit Surface step.

32. Double-click the Value column for the parameter 02=ROI definition step and enter the
program step in which you specified the ROI for the conveyor belt, that is the ROI
Union step.

33. Set the type of surface to be fitted by double-clicking the Value column for the
parameter 03=Surface type and choose Plane surface from the menu.
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Interactive setup windows are also used in some tools for entering parameter values. In
these windows captured images are used to provide feedback for the settings. Parameters
can be set interactively in three different ways:

¢ |nthe Preview window

* By clicking the button with three dots ( ..|), that is displayed when a parameter is
double-clicked

¢ By double-clicking the Setup field that is displayed at the bottom left corner of certain
program steps

The Grab Setup window, which we used earlier to set up the camera, is one example of an
interactive setup window.

As another example, it is usually much easier to adjust the size and location of the ROI
directly in the image in a preview window than entering coordinates for the rectangle in the
Value column:

34. Select the ROI rectangle step “ROI for the loaf”.

A rectangle is shown in the upper preview window. This is the default ROI that is set
for a new ROI rectangle.

35. Move and resize the rectangle in the preview, so that it marks the area where you can
see the shape of the loaf of bread.

36. In a similar manner, set the ROl rectangle for the step “Conveyor belt to the left” so
that it marks a section of the empty area to the left of the loaf.

If you need a larger window to work in, you can double-click a preview to open it in a sepa-
rate window. In this window you can fine-tune the parameters settings, for example if there
are small details in the image.

Before moving along, we will just add the last ROl Rectangle (for the area to the right of the
loaf of bread) and set the rest of the parameters for the steps that we have added this far.

37. Select the “Conveyor belt to the left” step and choose Edit > Copy from the main
menu.

38. Choose Edit > Paste and paste the step after the current step.
39. Move the rectangle in the preview window to the right of the loaf of bread.
40. Change the description of the program step to “Conveyor belt to the right”.
41. Set the following parameters for the remaining steps:
ROI Union 01=ROI A definition step Step number of “Conveyor belt to the left”
02=ROI B definition step Step number of “Conveyor belt to the right”
Volume 02=ROI definition step Step number of “ROI for the loaf”
03= Surface definition step  Step number of the Fit Surface tool

42. Execute all the steps in the camera by selecting the first ROl Rectangle step (“ROI for
the loaf”) and choose Debug > Step by step or press the F8 key until all steps in the
program have been executed.
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44.2 Using Tables and Results from Other Steps

The table is very useful for storing constants and results of calculations that we need to
use later.

For example, to calculate the desired volume of a slice of bread we can use the table for
setting the number of slices to make, and to store the desired volume of a slice to be used
later when we decide where to cut.

43. Double-click in the Value on Device column of an empty row in the table and fill in the
number of slices to make. Fill in a description of the value in the Description column of
the row, for example “Number of slices”.

The row is now highlighted in the table, indicating that the value on the device differs
from the value in the database.

Value on
Device

DE alue D escription

Mumber of slices

Table - Slice

olo|jloojo|lo|o(o

QLI ee

i

44. In the table, right-click the value in the Value on Device column and choose Copy
Device Value to the DB to synchronize the value on the PC with the value in the device.

45. Add a Mathematical Operation tool (from the Calculation toolbar) to the program.
46. Set the parameter 03=Mathematical operation to / (Division) and fill in a description.

47. Click in the Table column for the parameter 02=Variable B and type in the number of
the table row in which you entered the number of slices.

48. This tool can store the result of the calculation directly in the table, so double-click the
Value column of the parameter 04=Table index and fill in the number of an empty row
in the table. Remember to fill in a description of the value in the table.

To calculate the desired volume of a slice we also need the total volume, which we calcu-
lated in the previous step. We may store the total volume in the table and read the value
from there, but we can also retrieve the value directly from the returned values of the step.

49. Double-click the Step column of the parameter 01=Variable A.

A Previous result dialog box is displayed. Here you can select a result from a program
step to use as parameter value.

£
1~ Step number - -
|

v
_l Cancel I

— Result-

il - Wolume (mm3) _'J

50. Choose the step number of the Volume step and then the first result from that step
(there is only one result to choose from) and click OK.

The number of the step and the result are entered in the Step and Result columns of
the 01=Variable A parameter and the current value is displayed in the Value column.
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The next step in our problem is to find where to cut the loaf of bread. This can be solved in

the following way:

1. Setathin ROI (1 pixel high) at the beginning of the loaf and set an accumulated
volume to O.

2. Calculate the volume of the thin part of the loaf that is inside the ROl and add this
volume to the accumulated volume.

3. Move the ROI 1 pixel at a time and add the volume inside the ROI to the accumulated
volume.

4. When the accumulated volume becomes larger than the desired volume of a slice, cut
the loaf (or just mark the location) and reset the accumulated volume.

We will use the table for storing both the current location (y-coordinate) of the moving ROI
and the accumulated volume.

Since we start at the beginning of the loaf, we can initiate the location of the moving ROI
with the y-coordinate of the ROI for the loaf. This value is currently hard-coded into a
program step, but if we instead store the coordinates and size of the ROI for the loaf in the
table, we can easily read the coordinate we need when initiating the moving ROI.

51. In the program step “ROI for the loaf”, copy the values of the parameters 03=X
coordinate, 04=Y coordinate, 05=Width and 06=Height and store them in the table. Fill in
descriptions for the table values and make in the program step read these values
from the table.

52. Add a Write to Table tool (from the System toolbar) to the program and set the following
parameters:

01=Value Row number in the table in which the y-coordinate of the ROI for the
loaf is stored.

02=Table index The table row in which to store the current location of the moving ROL.

We can now reset the accumulated volume, set the moving ROl and calculate the accumu-
lated volume.

53. Add another Write to Table tool and fill in the description “Reset accumulated volume”.
Set the following parameters:

01=Value 0

02=Table index The row number in the table in which to store the accumulated
volume. Remember to fill in a description of the value in the table.

54. Add a ROI Rectangle tool and fill in the description “Set moving ROI”. Set the following
parameters:

03=X coordinate = The x-coordinate of the ROI for the loaf
04=Y coordinate  The current location of the moving ROI

05=Width The width of the ROI for the loaf
06=Height 1
55. Add a Volume tool and fill in the description “Volume in moving ROI”. Set the following
parameters:
02=ROI definition step Step number of the “Set moving ROI” step

03=Surface definition step  Step number of the Fit Surface tool

¥ 8- Calculate desired volume of a slice
WE 9 - [nitiate moving RO

wE 10 - Reset accumulated volume

11 - Set maving RO

&# 12 -Volume in moving RO
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443 Setting Parameter Values with Expressions

To add the volume inside the moving ROI to the accumulated volume, we need to read the
current accumulated volume from the table, perform the addition and then store the new
value back to the table. By using an expression we can do all that in one program step.

56. Add another Write to Table tool and fill in the description “Add to accumulated
volume”. Set the following parameters:

01=Value =V<row> + S<step>R1l

where <row> is replaced with the table row number in which the
accumulated volume is stored, and <step> is replaced with the
step number of the “Volume in moving ROI” above.

02=Table index The row number in the table in which the accumulated volume is
stored (the same as <row>).

Add to accumulated volume

w

Write to Table
01 =Value 207+ S14R1 | |
02 =T able index 7l e ]

Time of execution [ws] 1]

The value of the parameter 01=Value is an expression that calculates a value each time this
step is performed. An expression always begins with an equal sign (=) and may contain:

¢ Constant values 360,4/7, etc.

e Table values Vn for the value in row n

e Results from other steps SmRn for result n of step m (for example S17R2)
e Parameters (arguments) in other steps SmAn for input parameter n of step m

¢ Functions sin(), abs (), etc.

Please note that a program using expressions will not necessarily execute faster than (or
even as fast as) a program where program steps are used for the same calculations. The
expressions need to be parsed each time the program step is executed, which will add
some time to the execution time.

Next, we will move the ROI 1 pixel to prepare for the next thin slice of loaf to be added to
the accumulated volume. We do that by increasing the location of the moving ROl by 1 - a
value that is stored in the table.

57. Select the program step “Add to accumulated volume” and choose Edit > Copy.
58. Paste the step after the selected step. Change the description to “Move moving ROI”.
59. Change the following parameters of the “Move moving ROI” step:

01=Value =V<row> + 1

where <row> is replaced with the table row number in which the
location of the moving ROl is stored.

02=Table index The row number in the table in which the location of the moving
ROl is stored (the same as <row>).

444 Using Conditions and Jumps
Since we intend to move the ROI along the entire bread loaf, we need to repeat the last
steps. In fact we need two loops in order to solve our problem:

¢ An inner loop that calculates the accumulated volume until we have a full slice, that is
when the accumulated volume is as large or larger than the desired volume for a slice.

e An outer loop that runs from 1 to (the number of slices - 1) and takes care of the loca-
tions where we should cut the bread loaf (there is no need to cut after the last slice).
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60.

61.

62.

63.

64.

65.

Select the “Set moving ROI” step and add a While tool (from the Program toolbar)
before the selected step.

Add an End tool at the end of the program and fill in the description “End of While”.
Set the parameter 01=Start step to the step number of the While tool.

For the While tool, set the following parameters:
01=Control expression = (V<accVolRow> < V<sliceVolRow>)

where <accVolRow> is replaced with the table row number in
which the accumulated volume is stored, and <sliceVolRow>
is replaced with the table row number in which the desired
volume of a slice is stored .

02=END step The step number of the “End of While” tool.

Select the “Reset accumulated volume” step and add a For tool before the selected
step.

Add another End tool at the end of the program and fill in the description “End of For”.
Set the parameter 01=Start step to the step number of the For tool.

For the For tool, set the following parameters:
01=Start value 1

02=End value The number of slices to make minus 1.
03=Increment 1
02=END step The step number of the “End of For” tool.

e 10- Far

wE 11 - Fleset accumulated volume
e 12 - While

e - Set moving RO

&% 14 -Yalume in moving RO

wE 15 - Add to accumulated volume
wE 1E - Move moving ROI

o1 17 - End of While

w1 18-Endof For

Now we just have to add a step after the inner loop that registers the location where the
bread loaf should be cut. We are going to save the locations in the table, in a number of
consecutive table rows.

66.

67.

Add a Write to table tool between the two End tools at the end of the program, and fill
in the description “Save location”. Set the following parameters:

01=Value An expression that calculates the value (current location of the
moving ROI - 1). This is the value to save since we incremented
the location after calculating the accumulated volume.

02=Table index An expression that calculates the row number of an empty row in
the table. The result of the For step can be useful in this case.

Add a Goto tool at the end of the program and set this step to jump to step 2.

If we do not add the last Goto step, the program will automatically jump to step O when it
reaches to the end.

It is usually a good practice to make sure that the program jumps to the right place after
reaching the end. This way we can avoid situations where we add steps intended to be run
only the first time the program runs, but that are executed every time.
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4.5 Testing and Running the Program

How do we know that the program we have written this far is working properly?

One way is to step through the program using Debug > Execute Step and Debug > Step by
Step. The result of each step is shown in the preview window and the Value column of each
parameter.

68. Use Debug > Execute Step and Debug > Step by Step to step through the program and
make sure that it gives the correct result.

Another way is to add some program steps that display the result of the analysis and run
the program.

69. Add a Copy image bank tool after the first Grab step.

We add this step in order to have a copy of the image to draw in. If we draw in the
original image the analysis could be affected. Also make sure that the bank is not
already used.

70. Add a Draw ROI tool after the Copy image bank tool.

This step draws the region of interest in the image. Make sure to draw in the image
bank with the copy of the image.

71. Add a Draw line tool after the “Save location” step. Set the parameters 01=Start point X,
02=Start point Y, 03=End point X and 04=End point Y so that the tool draws a line across
the ROI for the loaf at the location of the cut, which is stored in the table. Make sure
to draw in the correct image bank.

72. Add a Display tool after the “End of For” step and set the parameter so that it displays
image bank 1.

73. Choose Debug > Run and watch the result in the Display window.

We are now done writing the example program, but there are - at least - two more func-
tions that could be added to the program:

e Making the cuts.

We could use either the outputs of the camera to directly control a knife that cuts the
loaf of bread, or we could have another device that controls the knife and send the lo-
cations where to cut to that device using either RS485 or Ethernet.

Before sending the locations, remember that the values stored in the table have the
unit “pixels”. It would probably be a good idea to get the calibrated positions (in millime-
ters) before passing them on.

¢ Improving the precision of the program.

Every slice - except the last one - will be slightly larger than the desired volume. This is
because we are working with a resolution of 1 pixel along the y-axis, and do not make
the cut until the accumulated volume is larger than the desired volume. If we add a
interpolation calculation that can give us a sub-pixel position where the accumulated
volume exceeds the desired volume, the precision of program could be greatly
improved.
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4.6 Saving the Program

To save the program we have written, use File > Save Product. This will save the program

on the PC (along with all other programs and tables in the product), but not on the device.
The program is present on the device as well, since it is downloaded to the device as you
build it.

But if the power to the device is cut, your program will be lost from the device and has to
be downloaded again from the PC. To prevent this from happening, you may save the
program in the flash memory on the device.

IVC Studio Device
| Product | Copied Working Flash
Devices E automatically Memory Memory

-

. Cameral  Associated
i Program

i Program E

| Program !

Camera 2 % ! % B a%'nks ]
Associated Active | 1

Table i Copy values : T;l;:/: ' E

i manually ' |

________________________

To download a program to a device without saving it in the flash memory:

1. Open the product containing the program.

2. Make sure the program is associated with the device and that a table is associated as
well.

3. Right-click the device in the list of devices and choose Start Program from the pop-up
menu.

The program is downloaded to the device and started. The status of the device is
changed from STOP to RUN.

When you save the program in the flash memory on the device, you choose a program
bank in which to save the program. You always save the program that is currently in the
working memory of the device. The table that is active is also saved with the program.

To save the program on the flash memory of the device:

4. Right-click the device in the list of devices and choose Flash > Write Program in Flash.
5. Select the program bank in which to save the program and click OK.
The program is how saved in the selected program bank.

If you save a program in program bank O, this program will start when the device is pow-
ered up. If you want the device to run a different program, you can load that program using
a PC, either by using an existing product (containing the program to be used), or by
downloading the program from the device’s flash memory.
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4.7 What’s Next?

In this chapter we have looked at the basics of how to handle IVC Studio, such as setting
up a product and writing a simple program. However, there are many features in IVC Studio
and the camera that have not been covered, which makes it possible to write advanced
programs for inspections and automation of production. Some of the features are:

¢ Using the camera as a stand-alone unit
e Using several devices in a product
¢ Using several programs on a single device

Using Cameras Stand-alone

Once the program is developed it can be downloaded to the device and started. Now the
program will run in the device until it is stopped, and it is no longer necessary to use IVC

Studio. If the program is also saved in program bank O on the flash memory, the program
will be started when the device is powered up.

If you want to interact with the device, you can write a program that for example communi-

cates with other equipment via the RS485 port, or set up a web page in the camera that
can be used for monitoring and controlling the device in a web browser on a PC.

Using Several Devices

A product may use several devices that each performs a certain inspection. It is also
possible to use the same device in several products and let the device run different
programs depending on the current product.

Device 1 \ Device 1
Product: Bottle — — — — — Product:Jar — — — — — —
Dev Program Table | | Dev Program Table )

1 Label Bottle_Label_Table 1 Label Jar_Label_Table |
2 Bottle_FillLevel Bottle_FiIILeveI_TabIe| [

\ 3 Jar_FillLevel Jar_FillLevel_Table |
/

U U — _— —_— —_— —_— — — — — —

To use several devices in the product, simply select the devices by clicking the checkbox in
front of them in the main window.

When the development is finished you can easily download the programs and tables to all
included devices at once by right-clicking Devices in the left pane of the main window and
choosing Product Transmission. This will also start the programs in the devices.

Using Several Programs

While there can be only one program in the working memory, additional programs can be

stored in the flash memory of the device. These programs can either be loaded manually

into the working memory, or they can be called from the active program.

e To load a program manually, use IVC Studio to associate the program with the device
and then start the program. This requires that the program is available in the product
that is open in IVC Studio.

If the program is not available on the PC, you can retrieve it from the device by right-

clicking the device in the list of devices and choosing Flash > Import Program from Flash.
¢ To call a program stored in flash from the active program, please refer to the Tools

section of this manual for information on which tool to use.

Note that calling a program stored in flash will load both a program and a table into the

working memory of the device, replacing the previous program and table there.
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51 Measurement Speed

The measurement speed is dependent on required resolution in the length (moving)
direction. The device grabs profiles at a rate determined by the settings in the software
tool Grab setup. The possible profile speed in a specific application is dependent on the
chosen measurement accuracy, the height of the field-of-view and the exposure settings.
The maximum profile rate is 5000 profiles/s in image mode and 3700 profiles/s in single
profile mode.

52 Field-of-View

The IVC-3D maximum field-of-view (FOV) is determined by the size of the housing, the lens
system and the laser fan angle. The FOV is placed at a certain distance from the device,
the stand-off or working distance, and is a trapezoid shaped area in the laser plane.

The field-of-view specification guarantees absolute mm values, divided into two cases:

1. Guaranteed FOV size:
a. The largest possible FOV for each individual camera (red trapezoids)
b. Useful when camera alignment is possible at installation to compen-
sate for individual variations in working distance
c. Typically possible in small deployments, e.g. system integrator use
2. Guaranteed FOV size and position for all units:
a. The common FOV, shared by all produced units (green trapezoid)
b. Useful to support easy replacements and repetitive installations,
when individual variations are not acceptable
c. Typical in repetitive deployments, e.g. OEM use

IVC-3D

Stand-off /
working distance

/ FOV width near,

" " A Stand-off variation
S|E Guaranteed FOV 4
o2 size and position 4 Guaranteed FOV
k= for all units ¥ size (not position)
Y /i \FOV height variation

FOV width far

Figure 5.1 - Explanation of IVC-3D FOV.
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Table 5.1 - Guaranteed FOV size. This table can be used for single installations.

Name

Type

Example FOV
(height x
width)

Max. height
range

Min. working
distance®

Width at min.
working
distance @

Width at max.

working

distance @

(1) Typical FOV sizes for applications using the different camera types

IVC-3D 30

IVC-3D31111
IVC-3D31112

30 x50 mm

31 mm

203-208 mm

53 mm

59 mm

IVC-3D 40

IVC-3D61111

40 x 90 mm

55 mm
195-204
mm

95 mm

115 mm

IVC-3D 50

IVC-3D21111
IVC-3D21112
IVC-3D21113

50 x 150 mm

84 mm

182-195 mm

134 mm

174 mm

IVC-3D 100

IVC-3D51111
IVC-3D51112
IVC-3D51113
IVC-3D51121

100 x 200

mm

139 mm

252-265 mm

179 mm

255 mm

IVC-3D 200

IVC-3D11111
IVC-3D11112
IVC-3D11113

200 x 600
mm

377 mm

288-306 mm

436 mm

810 mm

IVC-3D

IVC-3D 300

IVC-3D41111
IVC-3D41112
IVC-3D41113

300 x 1000
mm

871 mm

265-282 mm

417 mm

1297 mm

(2) The specified values are valid for the standard aluminum models, as shown in the Grab setup software. The housing
of the stainless steel models (type codes ending with 3) is 6 mm larger where the laser light exits, which is not
compensated for in either the Grab setup or in this table.

Table 5.2 - Guaranteed FOV size and position for all units. This table shall be used to guarantee
easy replaceability or for repetitive installations.

Name

Type

Example FOV
(height x
width)

Max. height
range

Min. working
distance®

Width at min.
working

distance @

Width at max.

working

distance®

(1) Typical FOV sizes for applications using the different camera types

IVC-3D 30

IVC-3D31111
IVC-3D31112

30 x50 mm

26 mm

209 mm

51 mm

57 mm

IVC-3D 40

IVC-3D61111

40 x 90 mm

42 mm

207 mm

92 mm

110 mm

IVC-3D 50

IVC-3D21111
IVC-3D21112
IVC-3D21113

50 x 150 mm

70 mm

196 mm

132 mm

172 mm

IVC-3D 100

IVC-3D51111
IVC-3D51112
IVC-3D51113
IVC-3D51121

100 x 200

mm

125 mm

266 mm

177 mm

253 mm

IVC-3D 200

IVC-3D11111
IvC-3D11112
IVC-3D11113

200 x 600
mm

356 mm

308 mm

432 mm

806 mm

IVC-3D 300

IVC-3D41111
IVC-3D41112
IVC-3D41113

300 x 1000
mm

850 mm

284 mm

413 mm

1293 mm

(2) The specified values are valid for the standard aluminum models, as shown in the Grab setup software. The housing
of the stainless steel models (type codes ending with 3) is 6 mm larger where the laser light exits, which is not
compensated for in either the Grab setup or in this table.
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Table 5.3 - Height resolution.

IVC-3D30 IVC-3D40 IVC-3D50 IVC-3D 100 IVC-3D 200 IVC-3D 300

Type IvC-3D31111 IVC3D61111 IVC3D21111 IVC3D51111 IVC3D11111 IVC-3D41111
IVC-3D31112 IVC-3D21112 IVC-3D51112 IVC-3D11112 IVC-3D41112
IVC-3D21113 IVC-3D51113 IVC-3D11113 IVC-3D41113
IVC-3D51121
Height 0.015mm  0.02 mm 0.04 mm 0.05 mm 0.2 mm 1.2 mm
resolution ¥

(1) Depends on the application, for example the object’s surface reflectivity

53 Stainless Steel Housing

The stainless steel housing is rated IP 67 and tested by ECOLAB (see the Cleaning recom-
mendations section) .The back plate is removable and can be exchanged with the protec-
tive hose accessory.

Figure 5.2 - Protective hose accessory.

The serial number and type code stickers are located under the back plate to withstand
washing.

Temperature cycling, which is typical in some washing procedures, may cause a pumping
effect where humidity enters the device. To prevent water condensation, each device is
equipped with a permanently mounted desiccant bag (60 g) inside the housing and an
exchangeable desiccant cartridge (14 g) located under the removable back plate. The
desiccant cartridge has a color indicator, which permanently turns from blue to pink when
the humidity has reached 80%.

54 Electrical Connections

All electrical connections are done via M12 plug-connectors. There are four connectors on

the side of the IVC-3D:
@ <) @ <)

o o E)o o
e © o e

Figure 5.3 - Side plate of IVC-3D with M12 connectors and LEDs
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Ethernet Connector

Pin Color

RS-485 connector + secondary outputs (female)

Pin Color ®

1 White
2 Brown
3 Green
4 Yellow
5 Gray
6 Pink

7 Blue
8 Red

(1) Color is valid for cable type STL-1208-

Signal
TX+
RX+
TX-

RX -

Signal
TRA
Reserved
Out 2
Reserved
GND
GND

TRB

Reserved

Operating Instructions
IVC-3D

@ @

@ ®

remark

Remark

Sum of Out 0, Out 1 and Out 2 <100 mA

Gnd for signals, current < 100 mA

Gnd for RS-485, current < 100 mA
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Power connector (male)

Pin Color @ Signal remark
1 White TriggerIn/In 0 HIGH = 10V ..... 28.8V
2 Brown DC 24V +20%
3 Green out 0 igrg r?]fAOUt 0,Out1and Out 2 <
4 Yellow out 1 igrg rc:jAOut 0, Out 1 and Out 2 <
5 Gray In1 max = Us (Supply voltage)
6 Pink In2 max = Us (Supply voltage)
7 Blue GND

Reserved @ Do not cpnnect for Class 2 (2M)
8 Red laser units.

Laser Supply ®  Supply for Class 3B laser.

(1)  Color is valid for cable type DOL-1208-GxxMA
(2) Do not connect for IVC-3D products with type code IVC-3Dxxx1x
(3)  Only in IVC-3D products with type code IVC-3Dxxx2x

Encoder Connector

Pin Color Signal remark

1 In1 RS-422 compatible
2 In2 RS-422 compatible
3 In2— RS-422 compatible
4 In1— RS-422 compatible
5 GND Current < 100 mA
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5.5 Technical Data
Table 5.4 - Technical Data for IVC-3D
IVC-3D 30 IVC-3D 40 IVC-3D 50 IVC-3D 100 IVC-3D 200 IVC-3D 300
Type IVC-3D31111  IVC-3D61111 IVvC-3D21111  IVC3D51111 IVC-3D11111  IVC3D41111
IVC-3D31112 IVC-3D21112 IVC-3D51112 IVC-3D11112 IVC-3D41112
IVC-3D21113 IVC-3D51113 IVC-3D11113 IVC-3D41113
IVC-3D51121
Image sensor CMOS
Max profile width:
Robust 1024 points 700 points
High resolution 2048 points 1400 points
Imaging angle 53° 53° 53° 61° 58° 60.5°
Laser filter 60 nm (FWHM)
Laser wavelength 658 nm + 15 nm
Laser class 2 (2M)or3B @
See chapter 1.1 and 1.2 for details
Laser modes DC and flash, software programmed
Power supply DC 24V +20%
Current <1A
consumption
Ripple <5 Vpp
Connectors Ethernet: M12, 4-pin, D-coded, female
RS-4851/0: M12, 8-pin, female
Power I/0:  M12, 8-pin, male
Encoder: M12, 5-pin, male
Digital inputs ®  3xHIGH=10V...28.8V
Digital outputs 3 x Class B; <100 mA ®
Communication RS-485
Interfaces Fast Ethernet (10/100 Mbit/s): TCP/IP, UDP/IP, EtherNet/IP
Including OPC Server
Encoder: RS-422
Max encoder 2 MHz
frequency
Operating 0°C ... 40°C
temperature
Storage -20°C ... 70°C
temperature
Shock load 15 g, 3 x 6 directions
Vibration load 5g, 58..150 Hz
Weight 3.2 kg 3.2 kg 3.2 kg 3.2 kg 4 kg 4 kg
5.5 kg 5.5 kg¥ 6.7 kg™ 6.7 kg
Dimensions 294 x 69 x 163 mm 387 x69 x 163 mm
(LxWxH)
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Enclosure rating

Housing material

Window material

Connector mate-
rial
(1
(2) One defined trigger
(4
5

5.6

IVC-3Dxxxx3

IVC-3D 30  IVC-3D 40

311 x 103 x 187 mm™

IP 65
P67

Anodized aluminum
Stainless steel®

Safety glass
PMMA®

Nickel-plated brass
Stainless steel®

IVC-3D51121 is equipped with a Class 3B laser

input

)
)
(3) 100 mA = total current of all digital outputs
)
)

Dimensional Drawings

IVC-3D 50

IVC-3Dxxxx2 and IVC-3Dxxxx3 have front windows in PMMA

IVC-3D 100

Chapter b

IVC-3D 200

404 x 103 x 187 mm®

239.8
445
N~ ™~
- ] <| N
© N o ©
L | (Ogm* ITI &1 ".«ajﬁ
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403.7

Figure 5.4 -IVC-3D 200 and IVC-3D 300 with anodized aluminum housing (not to scale)
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Figure 5.5 - IVC-3D 50 and IVC-3D 100 with anodized aluminum housing (not to scale)

161.7
32

119.4

6
16
o
19|

10.7
46

16.7 95 95 52 -

23.65

69.1

13.2

310.7

Figure 5.6 - IVC-3D 30 and IVC-3D 40 with anodized aluminum housing (not to scale)
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Figure 5.7 — IVC-3D 200 and IVC-3D 300 with stainless steel housing (not to scale)
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Figure 5.8 - IVC-3D 50 and IVC-3D 100 with stainless steel housing (not to scale)
(1) Fastening threads (2) Laser unit (3) Image sensor
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A Connecting an encoder

It is recommended to use an encoder for profile triggering to ensure proper images of
objects despite shifts in conveyor speed or direction. This chapter provides details on how
to connect an encoder to the IVC-3D.

Warning

The 2 channel Encoder Inputs are differential. Standard input voltage operation normally
at OV ... +5V. Operation in the range of -7V ... +12V is possible but must not be exceeded.

A.1 Requirements on the encoder

The encoder to be connected to the IVC-3D must fulfil two requirements. First, it must be
an incremental encoder. Second, the encoder must have a TTL/RS422 interface.

A.2 Connecting an encoder to the IVC-3D camera

Before connecting an encoder to the IVC-3D camera you have to decide how you want to
perform the 3D scans in your application. There are two possibilities available

e Scanning in one direction only

e Scanning in both forward and backward directions

The encoder has to be connected in a specific way depending on scan method. This is
exemplified in the two following chapters.

Scanning in one direction only

The IVC-3D camera has an encoder pulse counter. With the connection described in this
section, this counter will only be incremented when scanning in the forward-direction to
avoid scanning the same object (or parts of it) twice. When backward motion occurs, the
scan will not resume until the conveyor moves forward again and has reached the turning
position, as in the figure below.

Scan
4—:
( No scan Resumed scan
- |

———————————————————— »  Forward
scanning direction

This connection requires two encoder channels (A/A and B/B ) to keep track of move-
ment and direction. On some encoders, the A~ and B~ are also referred to as “CHA compl”
resp. “CHB compl”. See the section “IVC-3D interpretation of the encoder signals” below
for a detailed description on how IVC-3D handles the encoder signals.

The internal camera logic will increment with every pulse in the forward direction, and
decrement with each pulse in the backward direction and only scan a profile when the
pulse counter reaches the preset number of pulses per profile (which can be configured in
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the IVC Studio Grab setup). The connection required to achieve forward-only scan is shown
in the table below.

IVC-3D connector: Encoder connector:

@

®
@

@

IVC-3D Encoder connector pin Encoder Connector and wire allocation
Pin (male connector) | Signal Female connector | Signal

1 In1 1 A

2 In2 2 B

3 In2" 3 B

4 In1 4 A

5 GND 5 Not Connected

With the above settings, the forward direction is given by the image on the
left (shaft pointing towards you, arrows indicate shaft movement.).

Note: No image will be acquired if the encoder is rotated in the backward direction.

Scanning in both directions

With the following connection, the encoder will increment the pulse counter on the IVC-3D
camera when scanning in both directions. This means that the IVC-3D camera is not
sensitive to the rotation direction of the encoder shaft and will therefore perform scans in
either direction. The camera is indifferent to whether the conveyor moves forward or
backwards.

Scan

Scan )

<—
(:; Scan
o

———————————————————— » Forward
scanning direction

In this case only one of the encoder channels (either A/A - or B/B ") is needed.
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IVC-3D connector: Encoder connector:
IVC-3D Encoder connector pin Encoder Connector and wire allocation
Pin (male connector) | Signal Female connector | Signal
1 In1 1 A
2 In2 2 GND (Bridge to Pin 5)
3 In2" 3 5V DC
4 In1" 4 A
5 GND 5 GND (Bridge to Pin 2)

Note:

e Either A/A or B/B™ can be connected to In 1/In 1. The other pins must be connected
as in the above table.

e GND is available on Pin 5 of the IVC-3D camera encoder connector, therefore it is
possible to bridge this to pin 2.

Important: This is only an auxiliary GND not a supply GND. Current must not exceed
100mA.

¢ If the encoder is supplied by 24V there is a need for voltage division to be able to get 5V
on pin 3, as shown in the following image.

+24V

4R
+5V (IVC 3D encoder connector pin 3)

GND

Note that if the encoder has a supply voltage level of 5V, then there is no need for voltage
division.

Testing the encoder configuration

The encoder configuration can be tested in the IVC Studio Grab setup

1. Add a grab setup step to an IVC Studio product

2. Select encoder controlled profile triggering

3. Move the encoder and read the Current tick counter value field

If the counter increments for both forward and backward movement, the setup will scan in
both directions and if the counter increments for forward and decrements for backward
movement, the setup will only scan when the encoder moves forward
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IVC-3D interpretation of the encoder signals

The encoder produces two differential signal pairs, A/A™ and B/B™, where A" is the inverse
of A and B is the inverse of B. The difference between the signal pairs A and B is a 90°
phase shift.

p-d

R

%E :%
90°

<— 360 ——>

A signal flank on the A channel while the B channel is low is interpreted as forward motion,
while a signal flank on the B channel while the A channel is low is interpreted as reverse
motion. The figure below shows the IVC-3D interpretation of signal levels (TTL). Voltage
levels between 0.8 and 2 are undefined. The minimum differential voltage at a signal pair
of the differential Encoder inputs for normal operation is 0.5V.

Input signal +5V
voltage High
2.0V
0.8V
Low
oV

Available encoder modes

From IVC 3.4, the robustness of the encoder interface has been improved to sustain noise
and vibrations. There are four modes available, and the default behaviour is the same as
in previous versions of the IVC. To be able to use all modes described below, both chan-
nels must be connected to the IVC, i.e. all four connections A/A™ and B/B™ must be used.

The behaviour is configured using the configuration file Smartreader.ini available on the
flash disk of the camera. The available modes are:

Mode Description

0 Encoder ticks increase regardless of direction.

1 Encoder ticks increase/decrease depending on direction. Default behaviour.

2 Robust mode. Both encoder channels must change to increase/decrease the
encoder ticks.

3 High resolution mode. A change in either of the encoder channels causes an
increase of the ticks. l.e. number of ticks/mm is four times the value in modes
0-2 above.
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